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Veuillez lire ce document attentivement
avant d’utiliser votre AquaVent 5.

Instruments de surveillance des eaux souterraines et des eaux de surface de haute qualité
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Remarque : pour plus d’informations sur I'utilisation de votre logger
AquaVent 5 avec les protocoles Modbus ou SDI-12,
veuillez vous référer aux guides de l'utilisateur séparés.

Connexions des cables du
connecteur de téte de puits

Compartiment
Pour commencer des piles
1. Veuillez télécharger le logiciel depuis www.solinst.com/

downloads, puis installer le logiciel Levelogger sur votre
ordinateur.

2. Installez les piles dans la Wellhead. La Wellhead utilise 4 piles

AA 1,5V au lithium remplagables par ['utilisateur. SPX

Wellhead
3. Raccordez la Wellhead et I'enregistreur au cable ventilé :
Ergot de positionnement dans les Cavité de positionnement
connecteurs de la Wellhead et de dans les connecteurs du
I'enregistreur cable ventilé

Base pour téte
de puits

Support de
suspension

Alignez la cavité de positionnement du connecteur du cable ventilé avec l'ergot
de positionnement du connecteur de la Wellhead. Poussez avec précaution les
connecteurs |'un vers l'autre. Tournez le connecteur du cable légérement jusqu'a
ce que vous perceviez un petit clic lorsque le raccordement correct se fait.

Cable ventilé

Tenir la téte
Tenir le cable
ventilé immobile

de put;t'ls Seulement tourner
immobiie l'accouplement

Ne serrez 'accouplement que tout en maintenant la téte de puits et le cable
ventilé immobiles. Serrez le raccord jusqu'a ce qu'il s'enclenche. Aucun filet ne
doit étre visible au niveau du raccord de la téte de puits. Ne tordez pas le cable
ventilé ou la téte de puits.

Suivez la méme procédure lors de la connexion de l'enregistreur au cable Enregistreur
ventilé. AquaVent 5

Remarque : reportez-vous & page 6 pour des consignes concernant
I'installation du support de suspension, comme illustré a
droite.
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4. Raccordez le cable du connecteur USB a Cable du connecteur
la prise 410 broches (protocole Solinst) : -
sur la Wellhead, puis branchez le cable du

connecteur USB a votre ordinateur.

Programmation de I’AquaVent Enregistreur 5

Remarque : assurez-vous que vous utilisez la derniére version du logiciel et du capteur (microprogramme)
pour |'enregistreur AquaVent 5 et la téte de puits Wellhead. Veuillez consulter le site www.
solinst.com/downloads ou utiliser la fonction de mise & jour du logiciel pour obtenir de I'aide.

1. Lancez le logiciel Levelogger, puis sélectionnez le « Com Port » (Port de communication)
correspondant a I'appareil connecté.

2. Dans l'onglet « Datalogger Settings » (Paramétres de I'enregistreur), cliquez sur I'icone | g
« Retrieve Settings » (Récupérer la valeur des parameétres). Cela affiche les parameétres B’@
de programmation actuelle pour I'appareil AquaVent 5 connecté.

3. Vous pouvez désormais personnaliser I'ID projet, les emplacements, la fréquence
d’échantillonnage, et les heures de début et de fin d’enregistrement de votre Aquavent 5.
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Remarque : vous pouvez cliquer sur le | ? | intégré au logiciel pour obtenir une bréve explication de la fonction
correspondante, par ex. Com Port, Datalogger Zero, Slate Mode, Time Synchronization, etc.

Démarrage et arrét des enregistreurs AquaVent 5

1. Sivous le souhaitez, saisissez une heure de démarrage et/ou d’arrét futur. Pour
. . PUATS PRy - r
commencer |'enregistrement immédiatement, ne saisissez pas d’heure de début future >
et cliquez sur l'icone “Start Now”.

Remarque : Lorsque l'icdne “Start” est sélectionnée, une fenétre s’ouvre pour indiquer la
quantité de mémoire disponible. En sélectionnant “Oui”, vous ignorez le message et
vous démarrez le collecteur de données immédiatement. La sélection de “Non” vous
donne la possibilité d’accéder a I'onglet “Controle des données” pour télécharger et/
ou supprimer des fichiers de données a I'aide de I'option “Télécharger et supprimer
des fichiers”, afin de libérer de la mémoire.

2. Lorsque “Oui” est sélectionné, tous les paramétres sont appliqués au AquaVent 5 et il
commencera |'enregistrement a I'heure spécifiée.

3. Pour arréter le AquaVent 5 immédiatement, cliquez sur I'icone “Stop Now”. @
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Téléchargement et utilisation des données Remarque

1. Cliquez sur I'onglet « Data Control » (Contréle des données) pour accéder a la P h |
fenétre « Data Control » (Controle des données). Cette fenétre se compose de our changer e
trois sections : les parameétres de configuration de I'enregistreur, les données répertoire par défaut
sous forme tabulaire et les données sous forme graphique. des données téléchar-

2. Pour télécharger des données a partir d’'un enregistreur connecté, gees, Utlllse? le menu
sélectionnez I'icone « Download Data from Datalogger » (Télécharger | « Conﬁguratzon » ( Cor?ﬁf
les données de I'enregistreur). Il existe quatre options pour le \£ guration) dans la partie

téléechargement de données : « All Data » (Toutes les données), supérieure de la fenétre
« Append Data » (Ajouter les données), « Partial Download » du logiciel. Sélectionnez
(Téléchargement partiel) et « Download and Delete Files » (Télécharger et « Application Settings »
supprimer des fichiers). Les données seront présentées sous forme de tableau (Paramétres de I'appli-

et de graphique. cation), puis saisissez

Remarque : le répertoire par défaut pour les données téléchargées et 3“ n gvigculgz aun a“gie{
sauvegardées est : <C:\Program Files\ Solinst\Levelogger4_6\ osster. Llliquez sur Y.
Data> Les données sont enregistrées dans un fichier * xle.

3. Pour sauvegarder des données, cliquez sur l'icbne « Save Data » (Sauvegarder les Ij

données), puis saisissez le nom désiré pour le fichier enregistré.

=1k
4. Pour exporter le fichier de données afin de les utiliser dans d’autres programmes, cliquez sur I'icéne 3
« Export » (Exporter). Le fichier peut étre exporté sous le format *.csv ou *.xml.
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Fenétre « Data Control » (Controle des données)
Visualisation en temps réel

L’onglet « Real Time View » (Visualisation en temps réel) fournit une mesure a I'écran des données
enregistrées par |'enregistreur connecté. Un taux de visualisation est configuré de maniére indépendante
de la période d’enregistrement de I'’AquaVent 5, de maniére & ne pas interférer avec I'enregistrement
interne en cours. Pour effectuer un relevé & tout moment, cliquez sur <7 et le relevé sera ajouté aux
données affichées. Les données peuvent étre exportées et sauvegardées.

Compensation des données

Cliquez sur l'onglet « Data Wizard » (Assistant des données) pour )

o N N . . . Les ajustements manuels
accéder a la fenétre « Data Wizard » (Assistant des données). Dans cette des données vous
fenétre, I'assistant vous guide a travers les ajustements manuels des permettent d’utiliser
données (altitude ou conversion de la hauteur d’eau) et les ajustements des mesures manuelles

N - . o . ) du niveau de I'eau pour
des parametres (unités, altitude, densité) sur vos fichiers de données ajuster vos relevés de
ouverts. Il est possible de compenser plusieurs fichiers de données profondeur jusqu’au
AquaVent a la fois. niveau de I'eau.
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Plages AquaVent 5

Les modeéles AquaVent 5 sont prévus pour une profondeur de
submersion spécifique. Le choix du modele dépend de la précision du
niveau requis et de la profondeur de submersion. Ce qui est important,
c’est que votre sélection doit étre basée sur les fluctuations maximales
prévues du niveau d’eau.

Profondeur
de submersion

Modéle
AquaVent 5

Précision

M5 5m (16,4 pi) +0,3cm (0,010 pi)
M10 10 m (32,8 pi) +0,5cm (0,016 pi)
M20 20 m (65,6 pi) +1cm (0,032 pi)

Principes de mesure

Les enregistreurs
AquaVent 5
détectent la
pression. Un tube
de ventilation vers
la surface permet
d’éliminer les effets
: barométriques (+B)
t sur le capteur de
pression (-B).

Les
enregistreurs
AquaVent 5
fournissent des
lectures (A)
de la pression
réelle de I'eau
juste au-dessus
du point zéro
du capteur de
pression.

St
T 1
__L ﬁi

—

ZEro
point

Vérification des relevés

La meilleure recommandation est de comparer les relevés AquaVent (L)
avec une valeur de profondeur par rapport au niveau d'eau (d) mesurée
manuellement (a 'aide d’un appareil de mesure du niveau d’eau).
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Remarque

L’enregistreur AquaVent
5 peut résister a une
surpression de 2 fois

la valeur de la plage
maximale prévue. Par
exemple, un modele
M10 peut supporter une
fluctuation de 20 metres
(60 pieds) et continuer

a mesurer la pression.
Cependant, la précision en
dehors de la plage prévue
n’est pas garantie.

Conseil

Il est recommandé de
mesurer manuellement

le niveau de I’eau avant
d’installer un enregistreur
AquaVent 5, peu de temps
apres son installation,
périodiquement pendant
la période de surveillance
et a la fin de la période
de mesure. Utilisez ces
mesures pour vérifier les
relevés de ’AquaVent 5
et pour les ajustements
de données plus tard.
Veillez a effectuer des
mesures manuelles aussi
prés que possible des
relevés programmées de
I’AquaVent 5.

Remarque

Pour ajuster toutes les
mesures dans votre fichier
de données AquaVent

5 a la profondeur de

I’eau en dessous d’un
tubage de puits (d),
mesurez Imanuellement
le niveau de I'eau a I'aide
d’une sonde de niveau
d’eau. Cette mesure

doit correspondre, en
termes de données et

de moment, avec un
enregistrement AquaVent
5. Utilisez cela comme un
point de référence dans
I'option « Manual Data
Adjustment » (Ajustement
manuel des données) dans
I’Assistant des données du
logiciel.
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Notes de terrain AquaVent 5
Avant le déploiement

¢ Programmez votre enregistreur AquaVent 5 a 'aide du logiciel Levelogger, en
saisissant les informations correctes pour I'identification du projet, le mode de
mémoire, le mode d’échantillonnage, la programmation, etc.

Remarque : il est conseillé de synchroniser les horlogers de tous les
enregistreurs AquaVent 5 utilisés pour un projet donné.

¢ Si vous le souhaitez, utilisez I'option de mise & zéro de I'enregistreur de
données dans le logiciel Levelogger pour mettre a zéro 'enregistreur a la
pression atmosphérique actuelle.

e Programmez une heure de démarrage programmée lorsque vous serez au
bureau ou lancez I'enregistreur AquaVent 5 sur le terrain a 'aide du logiciel
Levelogger pour PC et d'un ordinateur portable, ou de I'’App Levelogger et
l'interface App Solinst Levelogger 5.

e Déterminez la profondeur du trou de forage, afin de vous assurer que
I'enregistreur AquaVent 5 ne touche pas le fond du puits (éviter la submersion
dans les sédiments).

Remarque : la longueur du cable ventilé ne doit pas étre confondue avec la
profondeur de déploiement car il peut y avoir un peu de mou
dans le cable, particulierement lorsque vous utilisez un support de
suspension

e Utilisez une sonde de niveau d’eau Solinst modéle 101 ou 102 pour mesurer
manuellement la distance a la surface de I'eau qui sera utilisée pour vérifier les
relevés de I'AquaVent 5.

e Déterminez les niveaux d’eau minimum et maximum prévus, les enregistreurs
AquaVent 5 devant rester immergés pendant toute la période de surveillance.

Déploiement

e Le systeme AquaVent est congu pour étre installé facilement sur un tubage
de puits de 5 cm (2 pouces), ou 10 cm (4 pouces) en utilisant un adaptateur.
Cependant, d’autres installations sont acceptables si des précautions adéquates
sont prises et les recommandations sont suivies.

e Laissez au moins 50 mm (2 pouces) de mou dans le cable ventilé a la surface
pour pouvoir soulever I'AquaVent Wellhead de la base du couvercle du puits, afin
d’effectuer une mesure manuelle du niveau de I'eau, sans perturber I'enregistreur
AquaVent 5 de sa position au fond du trou.

e Les tétes de puits ont un indice de protection IP64 (résistantes a la poussiere
et aux éclaboussures) et ne doivent donc jamais étre submergées. Il est
possible de les fixer a I'intérieur d’un boitier, mais dans ce cas, le boitier doit
&tre aéré pour égaliser la pression atmosphérique.

o Veillez a ne pas laisser tomber votre enregistreur AquaVent 5 dans I'eau,
abaissez-le soigneusement. Ne I'installez pas dans des endroits ot des « coups
de bélier » ou des « ressauts hydrauliques » (augmentation importante et trés
soudaine de la pression) peuvent se produire.

o Veillez & ne pas entailler ou plier le cable ventilé pendant 'installation. Rayon
de courbure de 25 mm (1 pouce) par mesure de précaution

Remarque : Pour des conseils, des précautions et plus d’informations sur
les installations dans différents environnements et applications,
consultez le dernier Guide de I'utilisateur des Dataloggers ventilés.

Apres le déploiement
¢ Mesurez manuellement la distance a la surface de I'eau aprés que le puits est
stabilisé (environ 10 minutes)

o Effectuez une autre mesure manuelle de la distance a la surface de I'eau juste
avant de retirer |'enregistreur AquaVent 5 du puits

Installation
du support de
suspension
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Communication sur le terrain
Deux options de cables SP Wellhead sont disponibles pour communiquer sur le terrain avec les
enregistreurs AquaVent 5.

e Le cable du connecteur USB vous permet de vous connecter a un ordinateur portable sur le terrain afin de
pouvoir communiquer a I'aide du logiciel Levelogger (voir illustration sur la page 1).

e Le cable de connexion App/DataGrabber vous permet de vous connecter a une interface App Levelogger
pour communiquer en utilisant I'’App Solinst Levelogger 5 ou DataGrabber 5 pour télécharger des données

sur une clé USB.
DataGrabber 5 Interface App Levelogger 5

14

Témoins lumineux : état de la connexion de

la Wellhead

Les tétes de puits AquaVent Wellhead possédent un voyant lumineux

Cable de connexion App/

DataGrabber
. \

Remarque

La téte de puits SPX Wellhead
posséde des définitions

multichrome qui indique I'état et le fonctionnement de 'AquaVent : | supplémentaires pour les

e 3 cycles de clignotement rapides alternant les trois couleurs : la téte de témoins lumineux, liées au
puits Wellhead se met en marche fonctionnement du MODBUS

e 10 cycles de clignotement rapides alternant le bleu et le vert : la téte de et du SDIF12.
puits Wellhead s’est connectée correctement & I'ordinateur en utilisant le Pour plus d’informations sur
cable de connexion USB les communications basées

sur les protocoles Modbus ou
SDI-12, veuillez vous référer
aux guides de I'utilisateur
correspondants.

e 10 cycles de clignotement rapides alternant le bleu et le rouge : la
connexion USB a été interrompue

e Jaune clignotant : la téte de puits Wellhead communique avec le logiciel
du PC

Entretien

Comme avec tout projet de surveillance, vous devez sélectionner 1'équipement approprié et définir
un programme d’entretien basé sur |'environnement spécifique a votre application.

Pour s’assurer que le tube d’aération reste sec, les enregistreurs AquaVent 5 et les tétes de puits
Wellheads renferment des produits desséchants permanents et des membranes hydrophobes au
niveau des raccordements au cable ventilé, de sorte qu'il n’est pas nécessaire de les remplacer.
Veuillez vous référer a notre bulletin technique pour plus de détails sur Conception, utilisation et
entretien du cdble ventilé.

Les autres conseils d’entretien comprennent (reportez-vous au Guide de I'utilisateur d’'un AquaVent
pour plus de détails) :

e Remplacez les joints toriques au niveau des raccords du cable ventilé sur I'enregistreur AquaVent 5 et la téte
de puits Wellhead.

e Lorsque des raccords ne sont pas utilisés, couvrez-les toujours avec des cache-poussiére.

¢ Lorsque vous ne les utilisez pas, enroulez toujours I'enregistreur AquaVent 5 et le cable ventilé sur leur
bobine pour les conserver.

e Avant I'assemblage, assurez-vous toujours que les connexions sont propres. Nettoyez I'enregistreur
AquaVent 5, si nécessaire.

¢ Remplacez les piles du Wellhead, si nécessaire (4 piles AA 1,5 V au lithium remplagables par I'utilisateur).

Fréquence d’échantillonnage de I’AquaVent 5 Estimation de I'autonomie des piles

8 relevés par seconde 10 jours
1 relevé par seconde 3 mois
1 relevé par minute 8ans
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Résolution des problémes

Logiciel Levelogger pour PC :
1. Vous devez disposer de privileges d’administrateur pour installer le logiciel sur un ordinateur.
2. Le systéme d’exploitation Windows 10 prend en charge le logiciel Levelogger.

Si votre enregistreur AquaVent 5 ne communique pas avec le logiciel Levelogger
pour PC ou si vous obtenez un message d’erreur de communication :

1. Vérifiez que les piles sont installées correctement :

e Assurez-vous que la polarité est correcte, en prétant attention aux symboles de borne positive
(+) et de borne négative (-) engravés dans le support

e Assurez-vous que 'alignement est correct : les contacts des ressorts dans le boitier doivent
atre alignés avec les contacts en saillie sur le bas du porte-pile
2. Vérifiez les connexions du cable ventilé a I'enregistreur AquaVent 5 et a la téte de puits Wellhead.

Assurez-vous qu’elles sont alignées correctement et qu’il n'y a pas des résidus ou de débris dans
le raccord.

3. Assurez-vous que vous utilisez le cable de connexion Wellhead correct pour vous connecter a
I'ordinateur.

e Vous devez utiliser un cable de connexion USB connecté a la prise Solinst & 10 broches sur la
téte de puits Wellhead. Le cable et le raccord sont de couleur orange.

4. Veérifiez que le cable de connexion USB est raccordé au méme port de communication que celui
choisi dans la partie supérieure de la fenétre principale du logiciel Levelogger.

5. Essayez de communiquer avec un autre enregistreur AquaVent 5, une téte de puits Wellhead, un
cable ventilé ou un cable de connexion USB.

6. Essayez d'utiliser un autre ordinateur.
7. Si le probleme persiste, contactez Solinst.

Pour réinitialiser 'indicateur de charge des piles AquaVent 5 apres le
remplacement de la téte de puits :

Rendez-vous a I'utilitaire de diagnostic dans le logiciel Levelogger, puis cliquez sur « Run Diagnostics »
(Lancer les diagnostics), puis sur « Reset AquaVent Battery Indicator » (Réinitialiser I'indicateur de la
pile de 'AquaVent 5).

Compatibilité des cables ventilés

Les cables ventilés de style plus ancien (vendus avant le 16/04/21 avec des numéros de série
inférieurs a 506326) ne sont pas compatibles avec les tétes de puits AquaVent 5 de style plus
récent (vendus apres le 5/7/21) ou les enregistreurs AquaVent 5 (vendus apres le 5/5/21) sans
une petite modification de I'utilisateur - contactez Solinst pour obtenir des instructions. Les cables
ventilés de style plus récent sont compatibles avec toutes les versions de I'enregistreur AquaVent -
veuillez noter qu’une fois le nouveau connecteur du cable ventilé entiérement serré, le joint torique
externe sur un ancien enregistreur ou téte de puits est visible et il est normal de ne pas s’asseoir
contre le connecteur .

Remarque : a des fins de diagnostic, vous pouvez installer I'extrémité du cable ventilé portant le numéro de
série au connecteur de surface de la Wellhead.
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